Week 6- Capture Surround Audio

Sound is an important aspect of any audiovisual medium. Just as the 360 video production
process is distinct from normal video production, 360 (ambisonic) sound production also differs
from traditional stereo audio production. Over the next few weeks, we will explore how to
capture, edit, and render audio for use in 360 videos for playback on YouTube.



Hearing Spatial Audio in 360 Videos

1

g

VR videos on YouTube, and other platforms, can use a variety of audio formats and with varying
degrees of success.

Audio might be stationary stereo, stereo encoded as spatial that rotates in 2D with the video, or
ambisonic that tracks with video movements in 3D.

Listen to this example! to hear how ambisonic sound should appear when panned correctly.

This example? of the ocean pans with the video and includes elevation.

Listen to audio on the 360 video examples? provided earlier in this course and note :

1. How spatial is the audio? Stationary stereo, 2D or 3D?

lhttps://www.youtube.com/watch?v=yoVbl-QPe9Q
Zhttps://www.youtube.com/watch?v=IdIYIbRL--0
3https://sway.office.com/6uj40grQT1YCkUv4?ref=Link



https://www.youtube.com/watch?v=yoVbl-QPe9Q
https://www.youtube.com/watch?v=ldlYlbRL--0
https://sway.office.com/6uj40grQT1YCkUv4?ref=Link

2. How complex is the sound design? A single audio track or multiple sounds mixed

together?

How is audio used to complement the video? Is it simply background ambience, added
music track, dialogue, sound effects, or a combination of these?

Does audio play a role in navigation (alerting viewers to actions in particular spatial
locations), add to the narrative with off-screen cues, use sounds to anticipate on screen
actions, or enhance the mood of the scene?

What to listen out for

-

Localising sound direction and distance

1.

Variations in Timing. When a sound comes from the left, the travel distance to your left
ear is slightly shorter than the travel distance to your right ear. So the left hears it
milliseconds before the right.

Variations in Volume. As we all know, sound gets softer as it moves further away. Sound
also gets softer when there are objects blocking it.

Variations in Frequency Spectrum. As we’ve just covered, when a sounds comes from
the left, your head blocks a portion of it from reaching your right ear. What you may not
know, is that it does not block all frequencies equally.

Amount of Reverb. That reverberant character of far-off sounds exists because almost
none of the sound reaches you directly. Instead, almost all of it reflects off multiple
surfaces before ever reaching your ears.

Pre delay. Pre-delay is the time gap between the first arrival of direct sound, and the
first arrival of reflected sound. In an environment with lots of reflective surfaces, sounds
heard from up close may still have a lot of reverb, but the time gap between the directed



sound and reverb will be large. Far-off sounds have a shorter pre-delay time, because
both sounds have to travel a great distance to reach you.

Source: “How Our Ears Sense the Direction of Sounds.” n.d. E-Home Recording Studio (blog).
Accessed May 13, 2022. https://ehomerecordingstudio.com/binaural-hearing/.

Resolving ambiguity

Whenever your brain is momentarily confused about sound direction, it triggers an instinctual
response for you to turn your heard to the side ever so slightly. This slight head turn creates
enough of a difference in the sound heard by each ear to allow your brain to figure out where
the sound is coming from.

Binaural sound

How we hear with two ears is called binaural hearing. Binaural audio is a two-channel audio
format with sound artificially arranged with the intent to create a 3-D stereo sound sensation
for the listener of actually being in a space with the sounding objects or instruments. This effect
is often created using a recording technique known as dummy head recording, wherein a
mannequin head is fitted with a microphone in each ear. It can also be simulated with computer
software processing of audio signals. Binaural recording is intended for replay using headphones
and will not translate properly over stereo speakers.

Sound Mapping

Sound mapping is a great practice in auditory awareness and observation. Stop in a location and
listen carefully to sounds around you. Draw a map with you at the centre and symbols for the
sounds you hear, indicating the direction and distance each is from you.

Download a sound mapping template here*.

4https://staticl.squarespace.com/static/5f68fe0eal51cb506833c405/t/5f74f92c4042532b39¢51811/16015014870
93/sound+mapping.pdfhttps://staticl.squarespace.com/static/5f68fe0eal51cb506833c405/t/5f74f92c4042532b39
c51811/1601501487093/sound+mapping.pdf



https://ehomerecordingstudio.com/binaural-hearing/
https://static1.squarespace.com/static/5f68fe0ea151cb506833c405/t/5f74f92c4042532b39c51811/1601501487093/sound+mapping.pdfhttps:/static1.squarespace.com/static/5f68fe0ea151cb506833c405/t/5f74f92c4042532b39c51811/1601501487093/sound+mapping.pdf
https://static1.squarespace.com/static/5f68fe0ea151cb506833c405/t/5f74f92c4042532b39c51811/1601501487093/sound+mapping.pdfhttps:/static1.squarespace.com/static/5f68fe0ea151cb506833c405/t/5f74f92c4042532b39c51811/1601501487093/sound+mapping.pdf
https://static1.squarespace.com/static/5f68fe0ea151cb506833c405/t/5f74f92c4042532b39c51811/1601501487093/sound+mapping.pdfhttps:/static1.squarespace.com/static/5f68fe0ea151cb506833c405/t/5f74f92c4042532b39c51811/1601501487093/sound+mapping.pdf

Eulmr\‘

https://sway.cloud.microsoft/KpnybN6ZmmeJlJcaeq#content=T4cdBxJOZNpgil



https://sway.cloud.microsoft/KpybN6ZmmeJJcaeq#content=T4cdBxJ0ZNpgil

Capture surround audio with the Zoom H2n and Zoom H3 recorders
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What is Sound?

Most sounds are made up of a complicated mixture of vibrations. Waveforms display the back
and forth changes caused by vibrations. A sound spectrum displays the different frequencies
present in a sound. We can tell the difference between sounds because of their unique sonic
spectra.

e Vibrations

e Air pressure changes
e Ear drum movement
e Aural perception

e Aural imagination

Direction of Sound Waves
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Microphones
e Diaphragms convert movement to electrical current.
e There are many types of microphone.

e Microphones have a specific directional response pattern, described by a
‘polar diagram’.



e The Zoom H2n has 4 microphones that can can be configured into a variety of recording
modes.

e Using Spatial Audio & 4 Chan modes on the Zoom H2n will capture sound from its 4
cardioid-pattern mics, two on the front and two on the rear. Spatial recording on a 2D
plane.

e The Zoom H3-VR mic will capture input from its 4 cardioid mics that point in different
directions around a full 360 degrees.

Read more about types of microphones.

Omnidirectional Unidirectional (Cardioid) Bi-directional (Figure 8)

Ambisonic audio

e Ambisonic audio format provides a spherical representation of sound using multiple
tracks for different dimensions (X, Y, Z...)

e |tis sometimes confused with traditional 'surround' sound used in films, which is not
truly 360.

e Special recorders are required to capture sound in ambisonic formats

Shttps://ehomerecordingstudio.com/types-of-microphones/



https://ehomerecordingstudio.com/types-of-microphones/

¢ The most basic Ambisonics format, the 4-channel B-format, is also known as first-order
Ambisonics.

- W is an omni-directional polar pattern, containing all sounds in the sphere,
coming from all directions at equal gain and phase.

- Xis a figure-8 bi-directional polar pattern pointing forward.

- Yis a figure-8 bi-directional polar pattern pointing to the left.

Z is a figure-8 bi-directional polar pattern pointing up

e Zoom H2n when in spatial audio mode, will record 4-channel Ambisonic B-format where
it essentially records W, Y, Z, X with the Z-axis (elevation) blank.

Example - Love is All Around: A 3602 Horror Story®

Shttps://www.youtube.com/watch?v=sd-W t7 AMw



https://www.youtube.com/watch?v=sd-W_t7_AMw

1- A typical Ambisonic microphone capsule with 4 diaphragms

Recording spatial audio with the Zoom H2n

1. Select Spatial Audio mode. Press menu - > Rec -> Spatial Audio -> On

2. Set recording format to 48K. Press menu - > Rec -> Rec Format -> WAV48K/24bit

3. Select 4 Channel mode, using dial on top

4. Adjust recording level

5. Position on tripod facing forward

6. Use a wind protector foam cover if outdoors

7. Press record, then again to stop

8. Press Play to play back on device

9. Transfer file to computer via USB cable.

e Turn off -> connect USB -> turn on -> select SD Card Reader,

e copy files from SD card to your computer's hard drive.
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Recording spatial audio with the Zoom H3-VR

1. Insert batteries and slide the on/hold button to power (left) then release. Press use Left,
Right and Enter buttons to select language and date (if required)

2. Position mic at recording location and orientate toward the point of view (note the
screen is the 'back' of the mic array).

3. Whilst the sound source is going adjust record level with the Mic Gain +/- dial on the

side.
4. Use a wind protector foam cover if outdoors
5. Press record, then again to stop
6. Press Play to play back on device
7. Transfer file to computer via USB cable.

e Turn off -> connect USB -> turn on -> select SD Card Reader,



e copy files from SD card to your computer's hard drive.

M Back

REC LED
This lights during recording, blinks when recording is paused, and blinks rapidly when the input sound level is
high.

®

Display
This shows various types of information.

®

REC button
Use this to start/stop recording.

®)

REW /A button
Use to search backward to a playback position in a file and to select items.

@

STOP/HOME button
Use to stop file playback and to open the Home Screen.

@

Power switch
Use this to turn the power ON/OFF and to disable button operation.

FF /W button
Use to search forward to a playback position in a file and to select items.

8 MENU button
Use to open the Menu and to return to the screen open just before the Menu.

®

PLAY/PAUSE/ENTER button
Use to start/pause playback of recorded files and to confirm items.

M Left and right sides

@

VOLUME buttons
Use to adjust the volume.

®

PHONE OUT jack
This can output sound to headphones.

™

MIC GAIN dial
Use to adjust the mic gain.

®

USB port
Connect this to a computer or iOS device to use the H3-VR as an audio interface or card reader.
The dedicated AC adapter (ZOOM AD-17) can also be connected here to use AC power.

@)

LINE OUT jack
This can output sound to a connected device.



Audio recording tips

Audio Settings in Premiere Pro
4 channel spatial audio

Audio resolution: 48000 htz
Audio bit depth: 16 or 24 bit
Recording Level

If your recording level is too low the background noise will be more prominent, if the recording
is too high then you may clip or exceed the max level and distort the sound. Always set your
recording level as high as you can without clipping, and keep the source reasonably close to the
microphone.

Proximity Effect

Many microphones change bass response as the distance from the mic varies. Sources close to
the mic have more bass, and this decreases as the source is further away. To get a recording rich
in bass frequencies, keep the source close to the mic.

Wind Noise



When recording outside, even a slight wind hitting the microphone will create noise and hiss in
the recording. Avoid this by staying out of the wind, using a protective filter or shield, or turning
on the low cut setting.

Recording as a Team

Tasks:

e Making Sounds (foley artist)
e Capture Sounds (recordist)

e Quality Control (producer)

Rotate through these roles to practice the recording tasks in your group



Adding surround audio to a Premiere Pro VR project

& Premierepro File Edit

Binaural Audio

We hear 360 sound with our two ears. Binaural audio simulates that effect in two audio
channels, but you need to wear headphones for it to work. We use binaural monitoring to hear
360 sound as we edit in premiere and when we listen on YouTube. But, binaural monitoring
needs to be disabled before we export the project from Premiere.

2 - Headphones in the 'ears' of a dummy head can be used for binaural recording

Steps to importing and playing ambisonic audio in Premiere Pro



10.

11.

12.

Start a new project in Adobe Premiere Pro

Create a new sequence: File -> New -> Sequence -> (Legacy ->) VR -> Monoscopic->
3840 Ambisonic

Adjust the video frame size to match YouTube format (3840 x 2160), in Sequence menu -
Sequence Settings.

Check that audio is set to Multi-Channel 4, and 48000 Hz sample rate, in Sequence
Settings

Check that Multichannel Mono Media is set to Adaptive in Edit -> Preferences ->
Timeline -> Default Audio Tracks -> Multichannel Mono Media

Import 360 assets into Premiere
Drag media (video and audio) into the sequence.

Synchronise if video and audio are from the same session. Select all tracks (video and
audio) and right click -> Synchronize

To see the audio waveforms, double-click the audio region in the sequence

Insert binaural playback plugin to hear spatial audio correctly on headphones.
a. Open Audio Track Mixer, and Click arrow on top left to show spots for plugins
b. On Master Channel, apply Binauralizer Plugin, under Special
c. Listen to the audio playback on headphones.

Use M and S buttons on the audio tracks to Mute and Solo individual tracks.

Currently, adjustments of the video and audio positions are not linked in Premiere Pro,
so change pan on the Binaural plugin to move it around to match the degree of rotation
of the video



Binauralizer -
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